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Getting started with WFSA Plus 03 

WFSA Plus 03 is an automated tool designed to improve decision-making and 
documentation for wildland fire management. The software helps you organize, 
analyze and present data used in preparing a Wildland Fire Implementation Plan 
(WFIP) and a Wildland Fire Situation Analysis (WFSA). 

A WFSA Prep program is provided to allow collecting information about suppression 
costs and fire impacts in advance. This information then can be used when developing 
a WFSA report. The WFSA Prep program produces a WFSA Prep file, which stores 
data used by WFSA Plus when comparing alternative strategies. 

Throughout WFSA Plus, you use a series of worksheets to gather and organize 
information about a wildland fire and possible responses. The results are presented in 
text, graphic and tabular formats. The final product is one or more printed reports. 

Each step in preparing each type of report is described here in the Guide to WFSA 
Plus, as well as in the online help. 

Installing WFSA Plus 03 

WFSA Plus 03 is distributed either electronically over the Internet or on CD-ROM. 

If you downloaded WFSA Plus 03 from the Internet: 

1 Locate the WFSASetup file. It probably will be in your email program’s 
Download folder. 

2 Select Run from the Start menu. 

3 Run WFSASetup and follow the instructions on the screen. 

 For example, in the Run dialog box you might type something like 

 c:\email\download\wfsasetup.exe 

If you received WFSA Plus 03 on a CD-ROM: 

1 Insert the CD-ROM. 

2 Select Run from the Start menu and run 

 d:WFSAsetup.exe 

 where d: is the name of your CD drive. 

3 Then follow the instructions on the screen. 

A note to users of previous versions of the software:  

If you try to open an old WFSA Plus ’98 file, the program will offer to create a 
WFSA Plus 03 file and then copy most of the information from the old file to the new 
file.  You can then make additional modifications to the new file. 

WFSA Plus 03 uses the same file format as WFSA Plus ’99, so no conversion is 
needed for existing WFSA Plus ’99 files. 
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Saving files in WFSA Plus 

WFSA Plus saves information when you enter it. There is no special Save command.  

To save the open file with a different name or to a different drive or directory, select 
the Save As command from the File menu. 

WFSA Plus works with one file at a time, so when you create or open a second file, 
the file that’s open is closed automatically. But, because information is saved when 
it’s entered, you don’t lose any data. 

Learning about the menu commands 

On the Menu bar at the top of your screen, you’ll find a few brief menus. These 
contain some basic commands you can use as you work. Generally, here’s what 
you’ll find on each menu. 

The File menu 

Use the commands on the File menu to open, save and import files, print reports and 
quit the program. 

New Starts a new WFSA Prep or WFSA Plus file  

Open Opens an existing WFSA Prep or WFSA Plus file  

Save As In the WFIP and WFSA programs, saves the open file under a new 
file name, directory or drive 

Printer setup Allows choice of printer, paper size, source and orientation and print 
quality 

Go to WFSA Allows you to switch from the WFIP to the WFSA program, keeping 
the file for the current fire open 

Go to WFIP  Allows you to switch from the WFSA to the WFIP program, keeping 
the file for the current fire open 

Exit Quits the program 

The Section menu 

Use the commands on the Section menu to open WFIP or WFSA sections. 

The Worksheet menu 

Use the commands on the Worksheet menu to open WFSA Prep, WFIP or WFSA 
worksheets. 

Note  You can also open sections by clicking their tabs at the bottom of the WFIP or 
WFSA windows. You can open worksheets by clicking their tabs at the bottom of 
the WFSA Prep windows or above the section tabs in the WFIP or WFSA 
windows. 
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The Edit menu 

Use the commands on the Edit menu to copy lists and to cut, copy or paste text. 

Note You can also edit information in many of the worksheets by highlighting the 
appropriate text, clicking your right mouse button and then selecting a command 
from the menu that appears. 

The Help menu 

Use online help for step-by-step instructions on using WFSA Plus. Online help is also 
where you learn about specific features of the software, such as printing reports and 
saving files.  

Getting around in WFSA Plus 

The chart below explains how you use various features (such as tabs) and devices 
(such as the mouse) to navigate your way around in the software. 

Use this item To do this 

Section tabs Section tabs appear across the bottom of each WFIP and 
WFSA screen. Each represents a step in the decision-making 
and documentation process. Click a tab to go to the section of 
the program it represents. 

Worksheet 
tabs 

Worksheet tabs appear across the bottom of each WFSA Prep 
screen and above the section tabs of each WFIP and WFSA 
screen. Each represents a procedure in the decision-making and 
documentation process. Click a tab to go to the worksheet it 
represents. 

Tab key Press to move forward from field to field on a worksheet. 

Mouse Click in a field to enter information. 

Click a number to select a priority rating. 

Click an item to select it. 

In text boxes, click the right mouse button to edit text. 

On-screen 
buttons 

Buttons appear on some worksheets when you have additional 
options. For example, the Add New Alternative button on the 
Strategies worksheet of the Alternatives section of the WFSA 
program lets you add another alternative. 

Menu bar 
options 

Select an option from a menu to perform a task (such as Open 
from the File menu) or go to a section or worksheet (such as 
Report from the Section menu). 
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New Features in WFSA 03 

Save the WFSA report to a word processor file  

It is now possible to save the WFSA report to a Rich Text Format (RTF) file, which 
can then be opened with a word processing program such as Microsoft Word. 

There are two issues to be aware of when saving to an RTF file.  First, on the Graph 
page, patterns are not supported in the RTF file, so the graphs will be transferred 
using solid colors, regardless of the settings you choose for the graph format.  Second, 
on the Signature page, several of the column headings are turned sideways: the text 
runs vertically rather than horizontally.  In the RTF file, this formatting is lost, although 
it can be easily restored from within most word processors.  For example, in 
Microsoft Word, select Text Direction from the Format menu to change the 
orientation of the text. 

 

Help compatibility 

The online Help has been updated to be compatible with current operating systems 
including Windows 2000 and Windows XP, as well as Windows 95, Windows 98 and 
Windows ME.  As a result, you should no longer see the error message “Run-time 
error ‘6’: Overflow” when trying to use the Help menu, or when exiting the program. 

 

Adding complexity factors 

A programming error was corrected so that it is now possible to add situation-specific 
complexity factors to any category. 
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Starting the WFSA Plus programs 

When you open the WFSA Plus program, you’ll see a row of three buttons, with a 
brief description above each, and the Exit button at the bottom. 

Use this button To do this 

WFSA Prep Open the WFSA Prep program. 

You use the WFSA Prep program to collect helpful information in 
advance, information that will be used by the WFSA program. 

Data about suppression costs and fire impacts can be copied from 
an Interagency Initial Attack Assessment (IIAA) database file or 
entered by hand. 

By storing these numbers, relating to costs and impacts, some of 
the more time-consuming parts of completing a WFSA can be 
completed in advance. 

WFIP Open the WFIP program. 

If the fire is not human caused, and you have an approved Fire 
Management Plan, you may be able to manage the fire for benefits. 

You use the WFIP program to assist in preparing WFIP reports, 
and to review whether managing the fire for benefits is appropriate. 

WFSA Open the WFSA program. 

Human caused fires, as well as those occuring in a location where 
a Fire Management Plan has not been prepared and approved, 
require a WFSA report. The WFSA program will assist you in 
preparing one. 

Exit Quit the program. 

 



Guide to WFSA Plus 
 

7

Working with WFSA Prep files 

A WFSA Prep file stores values for computing suppression costs and impacts on 
resource values when completing a WFSA. 

Setting up the WFSA Prep file in advance saves precious time when a fire is burning 
and a WFSA must actually be prepared. It also provides more accurate estimates of 
costs and impacts. 

Typically, a single WFSA Prep file is prepared for each administrative unit. The file 
then can be distributed to any computer on which WFSA Plus is installed. 

If you have an existing Interagency Initial Attack Assessment (IIAA) database file, 
WFSA Plus can use information from that file to create an WFSA Prep file. 

When a fire occurs, you select the WFSA Prep file containing data for the affected 
unit. Then, when you have WFSA Plus compute estimated costs and impacts of the 
fire, the estimates will be based on data appropriate for the location of the fire. If 
necessary, you can modify the data to fit the specific circumstances of the fire. 

Procedures 

1 After opening the WFSA Plus program, click the WFSA Prep button to start the 
WFSA Prep program. 

2 From the WFSA Prep welcome screen, if you wish to: 

• create a new WFSA Prep file , click New and then follow the instructions 
under Creating a WFSA Prep file below. 

• open an existing WFSA Prep file , click Open on the WFSA Prep screen 
and then select the file you wish to open. The instructions beginning with 
Worksheet 2: Management Goals on page 8 will help you review and edit the 
file. 

ä Creating a WFSA Prep file 

1 When you click New on the WFSA Prep screen, the Name the WFSA Prep file 
dialog box appears. 

 The file name uses a format of three characters identifying the unit, the two-
character state abbreviation, and the final two digits of the year, with an extension 
of FCD. For example, the Miles City District in Montana will use the file name 
MCDMT03.FCD. 

2 Type in the 3-character unit identifier. 

If it’s unique in the database, the unit name and state will be filled in immediately. 

If you’re unsure of the 3-character ID, or if the same ID is shared by more than one 
unit, you can type part of the ID or part of the Unit Name. A list of matching or 
similar unit names will be displayed in the ID Finder. If yours is in the list, click on 
it and the information will be filled into the boxes immediately.  

In some cases, your Unit Name and ID may not be in the database. If this happens, 
you’ll need to type in the Unit ID, Unit Name and state, yourself. Please notify 
Balance Technologies (see the title page for contact information), so that we can 
update the database.  
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3 Click OK to accept the filename and go to the Introduction worksheet. You’re 
now ready to enter and edit data.  

ä Worksheet 1: Introduction 

The Introduction worksheet, which is displayed when you’re starting a new WFSA 
Prep file or opening an existing one, provides an overview of the WFSA Prep 
process. 

The title bar displays the file you’re working with; you’ll also see the tabs for the five 
other worksheets across the bottom of the screen. 

ä Worksheet 2: Management Goals 

You can record resource management objectives, standards and guidelines for 
wildland fire suppression for each Resource Management Area (RMA). 

1 When you click the Management Goals tab, you’ll see three Management text 
boxes and buttons that allow you to add or remove RMAs. 

When you’re creating a WFSA Prep file, the boxes will be blank. When you’re 
reviewing and editing an existing file, these boxes will display previously entered 
information. 

2 To add an RMA, you click the Add Management Area button. 

3 Then type the RMA’s name into the Resource Management Area box. 

4 Press Tab, and then type the objectives for the RMA that are relevant to fire 
suppression into the Management Objectives box. 

5 If you want to: 

• add more RMAs, repeat Steps 2 through 4 above until you’ve typed in 
names for every RMA and described the objectives for them. 

• review or retype an RMA, click the appropriate management area in the 
Management Areas box at the left. You can then review and edit the 
objectives for the area you’ve chosen, or click in the Resource Management 
Area box at the right to change the RMA’s name. 

• delete an RMA, click in the Resource Management Areas box on the RMA 
you want to remove, and then click the Delete Management Area button. 

Note The management objectives for the RMAs aren't printed in the WFSA report. 
They will be available for reference when suppression objectives for a fire are 
being established. 

 The suppression objectives for a specific fire appear in its WFSA report.  

After you finish reviewing and editing the RMAs and objectives, you can click the 
Suppression Resources tab to review and edit the suppression resources. 
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ä Worksheet 3: Suppression Resources 

When you click the Suppression Resources tab, you’ll see a list of cost estimates for 
suppression resources.  

You can: 

• edit resource names, short names, units or costs by clicking the appropriate 
boxes and typing in your changes. 

• change the order of listed items by typing new numbers in the “#” column. 

• add items  to the list by clicking the Add Item button and entering the 
appropriate information into the Add Suppression Resource dialog box. 

• delete items  from the list by first clicking the number of the item and then 
clicking the Delete Item button. 

After you finish reviewing and editing the suppression resources list, you click the 
FMZs tab to list the FMZs and Representative Locations. 

ä Worksheet 4: FMZs 

On the FMZs worksheet, you list the FMZs and the Representative Locations for your 
administrative unit. You can import the data you need from an existing Interagency 
Initial Attack Assessment (IIAA) file and then add items as needed, or you can enter 
data by hand. 

1 When you click the FMZs tab, you’ll see a table with the headings “Fire 
Management Zone” and “# RLs,” as well as the Import from IIAA… and Add 
Item buttons. 

2 To import data from an existing IIAA file: 
 

1) Click the Import from IIAA… button. 

The Select IIAA file dialog box appears. 

2) Double click the IIAA file you want to use. WFSA Plus will copy the needed 
data into the current WFSA Prep file. 

3) The FMZs and Representative Locations from the IIAA file will appear in 
the table. You can, if needed, edit the FMZ names and change the number of 
Representative Locations (RLs). 

4) Enter additional FMZs, as needed, by clicking the Add Item button and typing 
in data. 

 
—Or— 

To enter FMZs and Representative Locations by hand: 
 

1) Click the Add Item button. 

2) Type in an FMZ and the number of Representative Locations. 

3) Enter additional FMZs, as needed, by repeating the above steps.  

After you finish reviewing and editing the FMZ table, you can click the NVC Table 
tab to enter or edit per acre cost estimates. 
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ä Worksheet 5: NVC Table 

For every FMZ and Representative Location in your administrative unit, you can 
review and change the estimated impacts on resources for each FIL. 

1 When you click the NVC Table tab, you’ll see drop-down lists for the FMZs and 
Representative Locations of the administrative unit, and a table that shows gains 
and losses for each FIL. 

If you entered data by hand in the Fire Management Zones worksheet, the table 
contains all zeros for those FMZs. If you imported an IIAA file, the numbers 
from that file are displayed in the table. 

2  To display the FMZs for your administrative unit, click the drop-down-list arrow 
to the right of FMZ. 

3 From the list, you select an FMZ to work on. 

4 To display the Representative Locations for the FMZ you selected, click the drop-
down-list arrow to the right of Representative Location. 

5 You click a Representative Location to work on. 

6 You click in the appropriate boxes (for example, Mature Timber, FIL 1) and enter 
your data. 

Note Remember to include the minus sign when entering losses. 

7 You select other Representative Locations and FMZs, and review and edit the 
data for them by repeating Steps 2 through 6 above. 

8 After you finish entering data, you can review the total estimated impact on 
resources for each FIL. The estimates are displayed in the row at the bottom of 
the table. To review the estimates for other FMZs and Representative Locations, 
click the appropriate drop-down lists. 

After you finish reviewing the estimated impacts on resources, you can click the 
Suppression Cost/Acre tab to edit suppression costs. 

ä Worksheet 6: Suppression Cost / Acre 

For each FMZ in the administrative unit, you can review and change the estimated 
per acre costs of suppressing fires. 

1 When you click the Suppression Cost/Acre tab, you’ll see the FMZ drop-down 
list for your administrative unit and a table that lists fire sizes and suppression 
costs. 

• If you typed in data by hand in the FMZs worksheet, the table is blank for 
those FMZs. 

• If you imported an IIAA file, the numbers from that file are displayed in the 
table. 

2 To display the FMZs for this WFSA Prep file, click the drop-down-list arrow to 
the right of FMZ. 

3 From the list, you select an FMZ to work on. 

4 Click in the appropriate box (the top one, if you’re starting with a blank table) in 
the To column and then enter the largest fire size for that particular cost per acre. 
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WFSA Plus will automatically insert the next larger figure in the next From 
column. 

Note If you enter 9,999,999 in the To column, WFSA Plus will assume it’s the last 
entry and won’t make an entry in the next From column. 

5 Click in the Suppression cost per acre column and type in the estimated cost per 
acre.  

6 Continue entering numbers in the To and Suppression cost per acre columns. 

7 You select other FMZs and review and edit the data for them by repeating Steps 
2 through 6 above. 

Note When you’ve finished making changes to the WFSA Prep file, you don’t need to 
take any specific action to save it–the file is kept up to date as you make 
changes. 

When you’re finished creating and editing WFSA Prep files, you quit the program by 
selecting Exit from the File menu. 

You can now distribute WFSA Prep files to the people who will prepare WFSAs for 
each fire in the administrative unit.  

ä Distributing WFSA Prep files 

Once a WFSA Prep file is created, it may have to be distributed to a variety of 
locations. For example, if a WFSA Prep file is created for a Forest, it may need to be 
distributed to individual Ranger Districts. 

To transfer a WFSA Prep file, you can use Windows Explorer to copy the file onto a 
floppy disk, and then copy it from the floppy disk onto the destination computer. You 
can find the WFSA Prep file in the costs folder. Normally this folder will be found in 
c:\wfsaplus. The WFSA Prep file should be copied into the costs folder on the target 
machine. 
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Creating a WFIP report 

Some wildland fires may qualify to be managed for benefits, rather than suppressed. 
The WFIP program may be used to assist in assessing whether a WFIP report should 
be prepared.  

If a WFIP is appropriate, you provide information for a WFIP report using the five 
sections of the WFIP program. Instructions provided in the following pages will help 
you follow each of the steps.  

Procedures 

1 After opening the WFSA Plus program, click the WFIP button to start the WFIP 
program. 

2 From the WFIP welcome screen, if you wish to: 

• create a new WFSA Plus file , click the New button or select New from the 
File menu, enter a file name and click Save. 

• open an existing file , click the Open button or select Open from the File 
menu, select the file you want to open and click Open. 

If you’re: 

• creating a new WFIP, you follow the procedures beginning with Section 1 / 
Stage I: Assess on the next page. 

• reviewing and updating an existing WFIP, Section 5 / Periodic Assessment, 
which starts on page 21, will help you work with an existing WFIP. 
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Section 1  /  Stage I: Assess 

To begin a WFIP, you describe the current fire situation, and then assess whether 
managing the fire for benefits is appropriate. 

ä Worksheet 1: Introduction 

When you open a WFIP to work with a particular fire, you see the Introduction 
worksheet for the Stage I: Assess section. It provides an overview of the Stage I: 
Assess section. 

The title bar displays the file you’re working with; you’ll also see the tabs for the 
WFIP sections in a row across the bottom of the screen. The tabs for the Stage I: 
Assess worksheets are in the row above the section tabs. 

To go to one of the other worksheets or sections, just click its tab. 

ä Worksheet 2: General Information 

1 When you click the General Information tab, you’ll see text boxes in which you 
enter identifying information about the fire. 

2 Here, you type in basic data about the fire including the name, jurisdiction, and 
start date and time. 

3 Press Tab to move from box to box. 

For more information about what to enter into each field, see the General Information 
data entry chart on page 14. 

ä Worksheet 3: Describe Conditions 

1 To describe the elements that affect containing the fire, click the Describe 
Conditions tab. 

You’ll see four text boxes. 

2 Here, you type in: 

• Fuel conditions (for example: extremely dry, heavy ground fuel) 

• Current and forecast weather (for example: humidity levels, wind, rain) 

• Current and forecast fire behavior (for example: direction in which the fire is 
burning) 

• Resources available to suppress the fire (for example: crews in the area, 
national crews, equipment) 

3 Press Tab to move from box to box. 

ä Worksheet 4: Risk Chart 

1 To assess the relative risk for the current fire, click the Risk Chart tab. 

 The Risk Chart worksheet appears, displaying a chart with four scales. 

2 You assess the relative risk by clicking the appropriate factors associated with 
each of the four scales. 

 The relative risk is indicated in the yellow box at the bottom of the screen. 

General information data entry chart 
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The fields on the General Information worksheet are listed below, along with the 
information you need to enter into each field. 

In this field Enter this information 

Fire Name (Self-explanatory) 

Incident number The agency number assigned to the fire (such as BOD 296 
or BNF 001) 

Jurisdiction(s) The agency that has fire protection responsibility (such as 
USFWS, USFS or BLM) 

Administrative Unit The local administrative unit (such as Hart Mountain Refuge 
Area or Flathead Indian Reservation) 

FMP Unit The Fire Management Plan Unit 

Geographic area The recognized Geographic Coordination Area where the 
fire is (such as Northwest or Northern Rockies) 

Management code The local unit’s fiscal management code 

Start Date/Time The date and time the fire started 

Discovery Date/Time The date and time the fire was discovered 

Current Date/Time The date and time the WFIP is being prepared 

Current Fire Size The size of the fire in acres 

Location (Lat/Long or 
Legal) 

The latitude and longitude of the fire or a legal description of 
the land involved 

Cause The cause of the fire 

ä Worksheet 5: Response Decision 

Once you’ve identified and described the fire, you need to document the decision to 
manage or attack it. To do so, you answer several questions about the fire. 

1 Click the Response Decision tab. 

2 You’ll see five questions, which you answer Yes or No by clicking the appropriate 
circles. 

3 If you answer: 

• No to all five questions , WFSA Plus indicates that you should manage the 
current fire for resource benefits. 

• Yes to at least one question, WFSA Plus indicates that you should initiate 
a suppression oriented response. 
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ä Worksheet 6: Next Step 

When you click the Next Step tab, you’ll see a diagram that displays the options that 
are available to you: whether to manage the fire for benefits, or to suppress it. 

If the results of the assessment suggest that: 

•  you manage the fire for benefits— 

You can click the Stage II: Short-term tab and go on to Section 2 / Stage II: Short-
term, which starts on the next page,  to continue the WFIP process, or click 
the Report tab and jump to Section 4 / Report, which starts on page 19, to 
preview and print the Stage I report. 

• you suppress the fire — 

You can click the Report tab and jump to Section 4 / Report, which starts on page 
19, to preview and print the Stage I report. 

If a WFSA report is needed, you can select Go to WFSA from the File menu, and 
go to Creating a WFSA report, which starts on page 23. 
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Section 2  /  Stage II: Short-term 

In the Stage II: Short-term section, you describe short-term implementation actions, 
assess the complexity of the fire, and determine whether a Stage III Long-term 
Action Document should be developed. 

ä Worksheet 1: Introduction 

When you click the Stage II: Short-term tab, you’ll see the Introduction worksheet, 
which provides an overview of the Stage II: Short-term section. 

ä Worksheet 2: Short-term actions 

1 When you click the Short-term actions tab, you’ll see the Initial Action Sections 
list, and a text box into which you enter information about each topic. 

2 One at a time, click on each topic name, and, in the Body text box, type in text 
pertaining to that topic. 

ä Worksheet 3: Complexity analysis 

Here, you rate a variety of characteristics of the fire situation to evaluate the 
complexity of the fire. 

1 When you click the Complexity analysis tab, you’ll see a list of complexity 
elements, which you assign values, and the Final Complexity Rating based on 
those values. 

2 Rate the complexity of each element by clicking in the box next to it in the 
“Value” column and typing in a value between 1 (low) and 5 (high). 

Note  You can press Tab to move from one element to the next.  

 When you’re satisfied with the value of each complexity element, you can review 
the Final Complexity Rating and the total assessment value in the yellow boxes at 
the bottom of the screen.  

 WFSA Plus determines the overall complexity value of the fire situation by 
multiplying each element’s weight by its value (the product appears in the W x V 
column) and then adding up the resulting products. 

ä Worksheet 4: Stage III need assessment 

1 To determine whether a Stage III Long-term Action Document is needed, click 
the Stage III need assessment tab. 

 You’ll see a chart with four scales. 

2 You assess the need by clicking the appropriate factors associated with each of 
the four scales. 

3 After reviewing the chart, click in the appropriate circle to indicate whether: 

• Stage III Implementation Actions should be developed and implemented. 

—Or— 

• Stage II Implementation Actions should be maintained. 
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ä Worksheet 5: Next Step 

When you click the Next Step tab, you’ll see a diagram that displays the options that 
are available to you: whether to create a Stage III plan, or to continue with the current 
plan. 

If the results of the assessment suggest that: 

•  a Stage III plan is needed— 

You can click the Stage III: Long-term tab and go on to Section 3 / Stage III: 
Long-term, which starts on the next page, to begin describing the Stage III 
actions for the fire, or click the Report tab and jump to Section 4 / Report, 
which starts on page 19, to preview and print the Stage II report. 

• you continue with the current plan— 

You can click the Report tab and jump to Section 4 / Report, which starts on page 
19, to preview and print the Stage II report. 
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Section 3  /  Stage III: Long-term 

In the Stage III: Long-term section, you describe objectives, risks and other elements 
involved in managing the fire for benefits. 

You can also copy Stage III text from another WFIP or another document, or paste it 
into a word processor document. 

ä Worksheet 1: Introduction 

When you click the Stage III: Long-term tab, you’ll see the Introduction worksheet, 
which provides an overview of the Stage III: Long-term section. 

ä Worksheet 2: Long-term Implementation Actions 

1 To describe the objectives, risks, and costs of managing the current fire, click the 
Long-term Implementation Actions tab. 

You’ll see the topics of the WFIP on the left, and a box where you can enter 
information describing aspects of the plan on the right.  

2 To enter text for each topic of the WFIP, click in the Implementation Plan 
Sections list on the topic name you want to select. 

3 Type in text that describes the implementation plan for that topic. 

By highlighting text and then clicking the drop-down lists and buttons above the text 
box, you can select different fonts, sizes and styles to change the appearance of 
the WFIP report. 

4 Continue highlighting topic names and entering text until you’ve completed each 
section. 

ä Worksheet 3: Import / Export 

1 First, click the Import / Export tab. 

The Import / Export worksheet appears. 

2 If you wish to import Stage III text from another WFSA Plus file, click the 
Import button and select a file. 

The Stage III: Long-Term Implementation Plan section will be copied from the 
selected file, and will be part of the WFIP report for the current fire. 

Note  Using the Import feature will replace any Stage III text already entered.  If you 
wish to import text, you should complete this step prior to making any other Stage 
III entries. 

3 If you wish to copy the Stage III: Long-Term Implementation Plan section to an 
external word processor, click the Export button. 

You can then read and edit the text using most word processing programs, such as 
WordPerfect or Word. 

When you’re ready, you can click the Report tab and go on to Section 4 / Report to 
preview and print pages of the WFIP report. 
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Section 4  /  Report 

In the Report section, you can create a documentation checklist for the report. 

You can also preview and print the entire report or selected pages from the Report 
worksheets. 

ä Worksheet 1: Introduction 

When you click the Report tab, you’ll see the Introduction worksheet, which provides 
an overview of the Report section. 

ä Worksheet 2: Table of Contents 

1 To indicate which documentation products are needed, and whether each one has 
been completed, click the Table of Contents tab. 

You’ll see a list of documentation products, with check boxes for each. 

2 To show which products are needed, click in the appropriate boxes in the Needed 
column. To de-select a product, click in its box again. A 3 means the item will 
show as "Needed" on the documentation checklist. 

3 To show which products are completed, click in the appropriate boxes in the 
Completed column. To de-select a product, click in its box again. A 3 means the 
product will will be marked "Completed" on the documentation checklist. 

Note To add a subsection, click in the list where you want the new subsection to go, 
then click the Add Subsection button, and type in the name for the subsection. 

ä Worksheet 3: Preview and Print 

1 To preview or print your WFIP report, click the Preview and Print tab. 

You’ll see the previewing and printing options that are available. 

2 To preview or print: 

• the full report, click the Select All button to be sure every page is selected. 

• selected pages, click the Clear All button, and then click the check boxes 
next to the pages you want.  

 An 8 in a check box means that page is selected. 

Note  If you have a color printer, you can print WFIP charts in color. The Chart 
Colors box allows you to preview and print in black and white patterns, colored 
patterns or solid colors. To select an option, click in the appropriate circle. 

3 Click the Preview button if you want to see your choices as they will appear 
when printed. 

The Print Preview screen appears. 
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4 From the Print Preview screen, you can 

 Click this button To do this 

 Previous or Next View other pages, if you’ve selected more than one page to 
preview. 

 Zoom In Zoom in to a smaller portion of the page. 

 Zoom Out See a larger portion of the page. 

 Print Page Print the page you see. 

 Print Report Print the WFIP report. 

 Close Return to the Print Report worksheet. 

Note You can also zoom in to a smaller portion of the page by double clicking the 
portion you want to view. 

5 When you return to the Print Report worksheet, you can: 

• preview other pages by repeating Steps 2 through 4. 

•  click the Print button to print your selections. 

• review and change the printer, paper size, source and print quality by clicking 
the Printer Setup button. 

When you’re through previewing and printing reports, you can: 

• go to one of the WFIP worksheets by clicking its tab. 

• switch to the WFSA program by selecting Go to WFSA from the File menu. 

• quit WFSA 03 by selecting Exit from the File menu. 
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Section 5  /  Periodic Assessment 

While a fire is being managed, you should periodically examine whether the decisions 
made for managing the current fire are still appropriate, and whether a long-term 
action plan is needed. 

ä Worksheet 1: Introduction 

When you click the Periodic Assessment tab, you’ll see the Introduction worksheet, 
which provides an overview of the Periodic Assessment section. 

ä Worksheet 2: Revalidation 

1 When you click the Revalidation tab, you’ll see a list of questions, similar to 
those on the Response Decision worksheet of the Stage I: Assess section. 

2 You answer the questions Yes or No by clicking the appropriate circles. 

3 If you answer: 

• No to all six questions , WFSA Plus indicates that you should continue to 
manage the current fire for resource benefits. 

• Yes to at least one question, WFSA Plus indicates that you should initiate 
a suppression oriented response. 

ä Worksheet 3: Next Step 

When you click the Next Step tab, you’ll see a diagram that displays the options that 
are available to you: whether to develop a Stage III plan, or to continue with the 
current plan. 

If the results of the assessment suggest that: 

•  you may continue to manage the fire for benefits— 

You can click the Stage III: Need Assessment tab and go on to Worksheet 4: 
Stage III Need Assessment below to continue the WFIP process, or click the 
Report tab and go back to Section 4 / Report, which starts on page 19, to 
preview and print the Revalidation report. 

• you should suppress the fire — 

You can click the Report tab and go back to Section 4 / Report, which starts on 
page 19, to preview and print the Revalidation report. 

If a WFSA report is needed, you can select Go to WFSA from the File menu, and 
go to Creating a WFSA report, which starts on page 23. 

ä Worksheet 4: Stage III Need Assessment 

1 To review whether a Stage III Long-term Action Document is needed, click the 
Stage III Need Assessment tab. 

You’ll see the same chart that appears on the Stage III Need Assessment worksheet 
of the Stage II: Short-term section. 

2 You can review the assessment that was made, and change it if necessary, by 
clicking the appropriate factors associated with each of the four scales. 

3 After reviewing the chart, click in the appropriate circle to indicate whether: 
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• Stage III Implementation Actions should be developed and implemented. 

—Or— 

• Stage II Implementation Actions should be maintained. 

ä Worksheet 5: Next Step 

When you click the Next Step tab, you’ll see a diagram that displays the options that 
are available to you: whether to create a Stage III plan, or to continue with the current 
plan. 

If the results of the assessment suggest that: 

•  a Stage III plan is needed— 

You can click the Stage III: Long-term tab and go back to Section 3 / Stage III: 
Long-term, which starts on page 18, to begin describing the Stage III actions 
for the fire, or click the Report tab and go back to Section 4 / Report, which 
starts on page 19, to preview and print the Stage III Need Assessment report. 

• you should continue with the current plan— 

You can click the Report tab and go back to Section 4 / Report, which starts on 
page 19, to preview and print the Stage III Need Assessment report. 
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Creating a WFSA report 

When you’ve determined that a WFSA is appropriate, you create a WFSA report 
using the eight sections of the WFSA part of the program. Instructions are provided in 
the following pages for each of the eight sections.  

Procedures 

1 After opening the WFSA Plus program, click the WFSA button to start the WFSA 
program. 

2 From the WFSA 03 screen, if you wish to: 

• create a new WFSA Plus file , click New and then follow the instructions 
under Section 1 / Setup below. 

• open an existing WFSA Plus file , click Open on the WFSA screen and 
then select the file you wish to open. 

Section 1  /  Setup 

You use the Setup section to prepare information that will be used later in the WFSA 
process. If you have a WFSA Prep file, the information can be imported directly. If 
you don’t have a WFSA Prep file, you can set up the tables manually. 

If a WFSA Prep file has been provided to you, you can review and edit the 
information by following the directions under Worksheet 2: Import Data below. 

If no WFSA Prep file has been provided, or if you wish to type in your own data, you 
can follow the instructions for Worksheets 3-6 of this section, starting on page 24. 

ä Worksheet 1: Introduction 

When you open a WFSA to work with a particular fire, you see the Introduction 
worksheet for the Setup section. It provides an overview of the Setup section. 

The title bar displays the file you’re working with; you’ll also see the tabs for the 
WFSA sections in a row across the bottom of the screen. The tabs for the 
worksheets of the Setup section are in the row above the section tabs. 

To go to one of the other worksheets or sections, just click its tab. 

ä Worksheet 2: Import Data 

You can import WFSA Prep files, which contain data that help with estimating the 
costs of suppressing a fire and the impacts of fire on natural resources in your 
administrative unit. 

1 When you click the Import Data tab, you’ll see on-screen directions and a list of 
available WFSA Prep files. 

2 Click on one of the WFSA Prep files to select it; then click the Next Step button. 

You’ll see a list of RMAs. 
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3 Click on all of the RMAs that may be affected by the fire, and then click the Next 
Step button. 

You’ll see a list of FMZs. 

4 Click on all of the FMZs that may be affected by the fire; then click the Import 
button. 

The screen displays lists of the RMAs and FMZs you’ve selected. 

5 You can add more RMAs and FMZs by clicking the Import additional 
RMAs/FMZs button, and then repeating Steps 2 through 4 above. 

6 If you need to delete an FMZ, you select it in the Fire Management Zones that 
have been imported box, and then click the Delete FMZ button 

When you’ve imported all of the WFSA Prep files that apply to the current fire, you 
can click the tabs for any of the other Setup section worksheets to review or edit the 
information. 

ä Worksheet 3: Management Goals 

You can record resource management objectives, standards and guidelines for 
wildland fire suppression for each RMA. 

1 When you click the Management Goals tab, you’ll see three Management text 
boxes and buttons that allow you to add or remove RMAs. 

When you’re reviewing and editing information that was entered previously, or 
imported from a WFSA Prep file, these boxes will display that information. When 
you’re creating the worksheet by hand, the boxes will be blank. 

2 To add an RMA, you click the Add Management Area button. 

3 Type the RMA’s name into the Resource Management Area box. 

4 Press Tab, and then type the objectives for the RMA that are relevant to fire 
suppression into the Management Objectives box. 

5 If you want to: 

• add more RMAs, repeat Steps 2 through 4 above until you’ve typed in 
names for every RMA and described the objectives for them. 

• review or retype an RMA, click the appropriate management area in the 
Management Areas box at the left. You can then review and edit the 
objectives for the RMA you’re working with, or click in the Resource 
Management Area box at the right to change the RMA’s name. 

• delete an RMA, click in the Resource Management Areas box on the RMA 
you want to remove, and then click the Delete Management Area button. 

Note The management objectives for the RMAs aren't printed in the WFSA report.  
They will be available for reference when suppression objectives for a fire are 
being established. 
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ä Worksheet 4: NVC Table  

1 When you click the NVC Table tab, you’ll see a table that shows the NVC for 
each FIL. 

When you’re reviewing and editing information that was entered previously, or 
imported from a WFSA Prep file, these boxes will display that information. When 
you’re creating the worksheet by hand, the table contains all zeros. 

2 Click in the appropriate boxes (for example, Mature Timber, FIL 1) and type in 
your data. 

Note Remember to include the minus sign when entering losses. 

3 Click one of the circles near the lower left corner of the window to include just 
losses, or to include both gains and losses–NVC. Your choice should conform to 
agency policy. 

4 After you finish entering data, you can review the total estimated impact on 
resources for each FIL. The estimates are displayed in the row at the bottom the 
table. 

ä Worksheet 5: Suppression Resource List 

1 When you click the Suppression Resource List tab, you’ll see a list of cost 
estimates for suppression resources.  

2 You can: 

• edit resource names, short names, units or costs by clicking the appropriate 
boxes and typing in your changes. 

• change the order of listed items by typing new numbers in the “#” column. 

• add items  to the list, one at a time, by clicking the Add Item button and entering 
the appropriate information into the Add Suppression Resource dialog box. 

• delete items  from the list, one at a time, by first clicking the number of the item 
and then clicking the Delete Item button. 

ä Worksheet 6: Cost / Acre 

1 When you click the Cost/Acre tab, you’ll see a table that lists fire sizes and 
suppression costs. 

When you’re reviewing and editing information that was entered previously, or 
imported from a WFSA Prep file, the table will display that information. When 
you’re creating the worksheet by hand, the table is blank. 

2 Click in the appropriate box (the top one, if you’re starting with a blank table) in 
the To column and then enter the largest fire size for that particular cost per acre. 
WFSA Plus will automatically insert the next larger figure in the next From 
column. 

Note If you enter 9,999,999 in the To column, WFSA Plus will assume it’s the last 
entry and won’t make an entry in the next From column. 

3 Click in the Suppression cost per acre column and type in the estimated cost per 
acre.  
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4 Continue entering numbers in the To and Suppression cost per acre columns. 

When you’re finished working with the Setup worksheets, you can click the Situation 
tab and go on to Section 2 / Situation to describe the current fire situation. 
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Section 2  /  Situation 

To begin a WFSA, you describe the current fire situation. 

ä Worksheet 1: Introduction 

When you click the Situation tab, you’ll see the Introduction worksheet, which 
provides an overview of the Situation section. 

ä Worksheet 2: General Information 

1 When you click the General Information tab, you’ll see text boxes, into which 
you type identifying and descriptive information about the fire. 

2 Here, you type in basic data about the fire including the name, jurisdiction, and 
start date and time. 

Note If you used the WFIP program for this file, many of these fields will already be 
completed. 

3 Press Tab to move from box to box. 

For more information about what to enter into each field, see the General Information 
data entry chart below. 

General Information data entry chart 

The fields on the General Information worksheet are listed below, along with the 
information you need to type in. 

In this field Enter this information 

WFSA # The number for the WFSA report 

Fire Name (Self-explanatory) 

Incident number The agency number assigned to the fire (such as BOD 296 or 
BNF 001) 

Start Date/Time The date and time the fire started 

Current Date/Time The date and time the WFSA is being prepared 

Jurisdiction(s) The agency that has fire protection responsibility (such as 
USFWS, USFS or BLM) 

Geographic area The recognized Geographic Coordination Area where the fire is 
(such as Northwest or Northern Rockies) 

Administrative Unit The local administrative unit (such as Hart Mountain Refuge 
Area or Flathead Indian Reservation) 

Management code The local unit’s fiscal management code 

Current size The size of the fire at the time the WFSA is being prepared 



Guide to WFSA Plus 
 
28

ä Worksheet 3: Conditions 

1 When you click the Conditions tab, you’ll see four text boxes, which you use to 
describe the elements that affect containing the fire. 

2 Here, you type in: 

• Fuel conditions (for example: extremely dry, heavy ground fuel) 

• Current and forecast weather (for example: humidity levels, wind, rain) 

• Current and forecast fire behavior (for example: the direction in which the 
fire is burning) 

• Resources available to suppress the fire (for example: crews in the area, 
national crews, equipment)  

3 Press Tab to move from box to box. 
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Section 3  /  Objectives 

The objectives for managing a fire are organized into categories. In this section, you 
describe the suppression objectives for the current fire, making sure that they’re 
consistent with the resource management objectives for the areas that the fire may 
affect. 

For example, if Forage is described as the protection of grazing allotments, is that 
objective for fire suppression compatible with the resource management objectives for 
the affected areas? 

Here, you also prioritize both the categories and the objectives by answering two 
questions: 

How important is each category relative to the other categories? For example, is 
Safety more important than Economics? 

Within each category, how important is each objective relative to the other objectives? 
For example, within the Environment category, is timber a greater concern than 
water? 

You can also review the relative priorities for each of the objectives, within their 
categories, and overall. 

ä Worksheet 1: Introduction 

When you click the Objectives tab, you’ll see the Introduction worksheet, which 
provides an overview of the Objectives section. 

ä Worksheet 2: Describe Objectives 

When you click the Describe Objectives tab, you’ll see a list of categories and 
objectives that influence fire management. You'll use the middle area to describe 
categories and objectives for the current fire. 

The boxes at the right display management objectives for the RMAs that may be 
affected by the fire. 

1 To describe a category or an objective, click on one (for example, “Economic”) in 
the Category/Objective list at the left. 

Your selection appears in the top box just to the right. 

Note The box is named Category when you’ve selected a category, and Objective 
when you’ve selected an objective. 

2 To enter a description of the selected category or objective, click in the 
Description box and type in a description of the suppression objectives. 

3 To add an objective, you click on the category the objective will be added to, click 
the Add Objective button, and then type in a name and description for the 
objective. 

4 To delete an objective, select it in the Category/Objective box and click the Delete 
Objective button. 
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5 You can review management objectives for an RMA by selecting an RMA from 
the Objectives for Management Area: drop-down list at the right. 

If management objectives have been entered for the RMA, they appear in the box 
under the drop-down list. You can review them to ensure that the suppression 
objectives for the fire and management objectives for the RMA are consistent. 

Notes If you wish, you can use the commands on the Edit menu to copy text from the 
management objectives and paste it into your descriptions of suppression 
categories and objectives. 

 The management objectives for the RMAs aren’t printed in the WFSA report. 
The suppression objectives for the current fire are printed in the report. 

6 Continue describing and editing categories and objectives by repeating Steps 1 
through 5 above. 

ä Worksheet 3: Prioritize Categories 

1 To prioritize the categories for the current fire, click the Prioritize Categories 
tab. 

You’ll see a table that lists the categories. 

2 You can indicate how important each category is relative to the others by: 

• clicking and dragging the blue bar next to each number in the Priority 
column. 

—Or— 

• clicking the number next to each objective in the Priority column,, and 
typing in a number between 0 (low) and 10 (high). 

The blue bars and the numbers reflect the importance of each category in relation 
to the others. 

1 Continue rating the categories until you’re satisfied with the results. 

The percentage each category contributes to the overall analysis appears in the % 
column. 

ä Worksheet 4: Prioritize Objectives 

1 To prioritize objectives for each category, click the Prioritize Objectives tab. 

You’ll see a list of categories, along with a table that lists objectives. 

2 In the Category list, you click a category to work on. 

The objectives for the category you’ve selected appear in the table at the right. 
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3 In the table, you indicate how important each objective is relative to the other 
objectives within that category by: 

• clicking and dragging the blue bar next to each number in the Priority 
column. 

—Or— 

• clicking the number next to each objective in the Priority column, and typing 
in a number between 0 (low) and 10 (high). 

The blue bars and the numbers reflect the importance of each objective in relation 
to the others within a category. 

1 Continue rating the objectives until you’re satisfied with the results. 

The percentage each objective contributes to the category appears in the % column. 

2 Rate the objectives for the other categories by repeating Steps 2 through 4.  

ä Worksheet 5: Summary 

When you finish setting priorities for categories and objectives, you can review your 
work to see how they all interrelate. 

When you click the Summary tab, you’ll see a table that lists all of the categories and 
objectives for managing the current fire. 

In the Category/Objective column, you see each category and objective you rated: 

The green rows  show information about each category—its priority, its weight 
overall and its description.  

The white rows  show information about each objective—its priority and weight 
within its category, the percentage it contributes to the overall decision, and its 
description. 

When you’re ready, click the Alternatives tab and go on to Section 4 / Alternatives to 
enter alternatives for controlling the fire. 
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Section 4  /  Alternatives 

In this section, you describe alternative suppression strategies to be evaluated. Each 
strategy should have a different primary focus; for example, minimizing fire size, 
minimizing suppression costs, or minimizing negative impacts of suppression activities. 

For each alternative, you identify the target outcome. You may also choose to 
describe fallback and worst case outcomes. The outcome descriptions include 
expected fire size and time estimates for containing and controlling the fire. 

You also indicate the probability of achieving each outcome. You have the option of 
describing the suppression resources needed to achieve each outcome. 

If the fire may affect more than one FMZ, you indicate the percentage of the fire in 
each FMZ for each outcome. 

ä Worksheet 1: Introduction 

When you click the Alternatives tab, you’ll see the Introduction worksheet, which 
provides an overview of the Alternatives section. 

ä Worksheet 2: Strategies 

1 When you click the Strategies tab, you’ll see boxes for naming, listing and 
describing alternatives. The bottom of the worksheet shows example strategies 
and descriptions. 

When you begin, the first alternative, labeled “Alternative A,” appears in the 
Alternatives box. The name you give the alternative will replace the phrase 
“Alternative A.” 

2 In the Strategy Name box, type the name you want to use for the alternative 
you’re defining. You might use such names as “Minimize fire size (min size),” 
“Minimize suppression costs (min costs)” or “Minimize negative impacts of 
suppression activities (MIST).” 

Giving the alternative a name makes it easy to identify later. 

3 Then press Tab or click in the Describe the general theme… box and type in a 
description of the strategy. 

You can enter as much text as necessary. 

4 To add an alternative, click the Add New Alternative button. 

Another alternative letter (such as B, C or D) appears in the Alternatives box. 

5 Repeat Steps 2 and 3 above. 

6 Repeat Steps 4 and 5 until you’re done adding alternatives. 

7 To remove an alternative, click on it in the Alternatives box, and then click the 
Delete Alternative button. 
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ä Worksheet 3: Outcomes 

Once you’ve entered the alternatives for attacking the fire, you can enter predictions 
about the outcomes for each alternative. 

1 When you click the Outcomes tab, you’ll see areas where you select the level of 
analysis and enter a description and estimated results for each outcome. 

2 To select the level of analysis, click one of the circles at the left of the screen: 

• One outcome for each alternative: You’ll enter a target outcome for each 
alternative and one worst case outcome for all alternatives. 

• Two outcomes for each alternative: You’ll enter a target outcome and a 
fallback outcome for each alternative and one worst case outcome for all 
alternatives. 

• Target, Fallback and Worst Case outcomes: For each alternative, you’ll 
describe three levels of potential outcomes. 

3 Then select an alternative from the Alternative drop-down list. 

If you selected the first or second option in Step 2 above, the Alternative drop-down 
list will display an "All Alternatives" option, as well as a list of alternatives. You 
use it to describe the worst case outcome for all alternatives. 

4 Depending on the option you selected in Step 2 above, the Outcome drop-down 
list will display one, two or three outcomes for each alternative. One at a time, 
select each outcome and provide descriptive information. 

5 Click in the Describe the outcome box to type in a narrative description of the 
selected outcome, such as locations of fire lines, or where suppression resources 
will be placed. 

6 Type your estimates of the final fire size and perimeter and of the days required 
to contain and to control the fire into the appropriate boxes at the bottom of the 
worksheet. 

7 To enter your predictions for each alternative and all outcomes, repeat Steps 3 
through 6 above. 



Guide to WFSA Plus 
 
34

ä Worksheet 4: Probabilities 

1 When you click the Probabilities tab, at the upper left, you’ll see the Alternative 
to describe: list. 

Beneath the list, a branch diagram begins to the right of the Strategy Name box. 

The top branch consists of a % Probability of success box and the Target Outcome 
box. 

If you selected the second or third level of analysis on the Outcomes worksheet, you 
see the second branch, the Fallback Plan. It consists of a % Probability of 
success box and the Fallback Outcome box. 

The Target and Fallback Outcome boxes display estimates of the final fire size and the 
number of days that will be required to contain and control the current fire. 

For all analysis levels, the bottom branch is the Worst Case Outcome box. It displays 
an estimate of the final fire size. 

The estimates for each outcome come from the Outcomes worksheet of this section 
or the Potential Size worksheet of the Situation section. 

2 In the Alternative to describe: box, you click an alternative to work with. 

The alternative appears in the Strategy Name box. 

3 In the % Probability Of Success box, type the percentage that represents how 
successful you think the target outcome will be (for example, 90 percent). 

4 If you selected the second or third analysis level on the Outcomes worksheet, you 
type the probability of success for the fallback outcome into its % Probability Of 
Success box. 

5 Continue selecting alternatives and entering the probability of success for each 
outcome by repeating Steps 2 through 4 above. 

ä Worksheet 5: Suppression Resources 

Note If you want WFSA Plus to use historical averages of suppression costs for the 
RMAs involved, rather than estimates of the suppression resources needed for 
the current fire, you can skip this worksheet. 

1 To select suppression resources for each alternative and outcome, click the 
Suppression Resources tab. 

At the top of the worksheet, you’ll see lists of alternatives and of the outcomes for 
each. To the right, you can review your predictions for the final fire size, and days 
needed to contain and control the fire. 

 For each outcome, you estimate the cost of the resources needed to suppress the 
fire. 

 
2 You click an alternative to work on, and then click an outcome (for example, “A. 

Min size” and “1. Target”). 
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3 You click a resource in the Select resources from: list at the left to select it. 

The resource is added to the Selected Resources: workspace at the right.  

4 In the Qty (Quantity) column, enter the number of such resources you require. 

5 In the Time column, enter the time period required for the resource (for example, 
4 shifts). 

WFSA Plus computes the total cost for the suppression resource. It appears 
automatically in the Cost column.  

6 Continue to select resources for the alternative and outcome you’re working on 
by repeating Steps 3 through 5 above. 

Notes  You can change the order of your selected resources by typing new numbers 
under #. 

 You can delete items one at a time by clicking an item in the list and then clicking 
the Delete Row button. 

7 Select another alternative or outcome from the lists at the upper left. 

If no Selected Resources list has already been prepared for the outcome, the Initialize 
Resource List dialog box appears. You’ll see the alternative and outcome you’re 
working on, as well as choices you can make. 

8 To start with: 

• a blank list of suppression resources, click new (blank) list, and then click 
OK. 

• a previously created list, click the alternative and outcome you want to 
copy, to highlight it. Then click OK. 

9 WFSA Plus returns to the Suppression Resources worksheet, where you can: 

• change the quantity and units for items in the list. 

• click on items in the Select resources from: list to add them to the list. 

• delete items by clicking the Delete Row button. 

• change the order of the items by retyping the numbers under #. 

10 Continue selecting alternatives and outcomes and filling out suppression resource 
lists by repeating Steps 2 through 9 as needed. 

Notes You can copy one list onto another at any time by selecting Copy resource list 
from… from the Edit menu. You can choose to either Replace existing list or 
Add to existing list. 

 You don’t need to create a resource list for every outcome. If you don’t create a 
list, the suppression costs for that outcome will be estimated based on the 
expected fire size. 
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ä Worksheet 6: FMZs 

Note If only one FMZ was selected on the Setup Import Data worksheet, you won’t 
see a tab for this worksheet. You skip this procedure and continue by following 
the instructions under Section 5 / Analysis on page 37. 

1 When you click the FMZs tab, you’ll see a list of the alternatives and outcomes 
for the current fire, with estimates of the final fire size for each. You'll also see a 
table that lists the FMZs. 

2 You click in the Outcome box to select an alternative and outcome to work with. 

3 In the table, for each FMZ, click in the Percent column to type in predictions of 
how much of the fire will burn in each Zone. 

4 Continue selecting alternatives and outcomes, and typing in the predictions. 

When you’re ready, click the Analysis tab and go on to Section 5 / Analysis to 
estimate the costs and impacts of each outcome. 
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Section 5  /  Analysis 

In this section, you rate each outcome for each alternative as to how well it satisfies 
the objectives you set up earlier. First, you select an objective to rate; then you select 
a rating for each outcome. 

You also estimate the impact of fire and smoke on two kinds of items: 

• Resources such as timber and water, and 

• Individual items such as structures and specific sites. 

WFSA Plus will calculate resource losses for the FILs that you specify. After you’ve 
entered your estimates, they appear in the Summary worksheet table. 

Finally, for each strategy, you estimate the cost of the resources needed to suppress 
the fire.  

ä Worksheet 1: Introduction 

When you click the Analysis tab, you’ll see the Introduction worksheet, which 
provides an overview of the Analysis section. 

ä Worksheet 2: Ratings  

1 When you click the Ratings tab, you’ll see a list of objectives and a table in which 
you rate each alternative and outcome for each objective. 

2 In the Objectives box, you click an objective to work with. 

The objective appears in the Outcome Ratings box. 

3 For each outcome: 

• click in the “Rating” column to indicate how well it satisfies the objective. 
You position the mouse toward the left to indicate less satisfaction, and to the 
right to indicate more. 

A horizontal bar appears in the column, and a number between 1 and 10 appears 
in the box to the left of the bar. 

—Or—  

• type the rating into the text box at the left of the “Rating” column. The 
horizontal bar appears at the right. 

4 Continue rating the outcomes for the selected objective. You can adjust the 
ratings by clicking and dragging the horizontal bars or by retyping the numbers. 

5 Select the next objective, and repeat Steps 3 and 4, until you’re finished. 

ä Worksheet 3: FIL  

1 When you click the FIL tab, you’ll see a table with column headings “FIL,” 
“Relative Amount” and “%.” 

Depending upon the options available, you may also see lists of alternatives and 
outcomes, and FMZs.  
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2 You click the circle next to: 

• “Use the same FIL settings…” if you want to use the same FIL settings 
for all alternatives and outcomes. 

• “Use separate FIL settings for each FMZ” if you want to use different 
FIL settings for each FMZ. This option appears only when more than one 
FMZ was selected on the Import Cost Data worksheet of the Setup section. 
Next, you select an FMZ from the Fire Management Zones (FMZs) list.  

• “Use separate FIL settings for each outcome…” if you want to use 
different FIL settings for each outcome. Next, you select an alternative and 
outcome from the Outcomes list. If more than one FMZ was imported, you’ll 
also need to select an FMZ from the Fire Management Zones (FMZs) list. 

3 To indicate the proportion of the fire area that will burn at each FIL, click in the 
“Relative Amount” column of the table. For example, if a major portion of the fire 
area will burn at FIL 4, you position the mouse toward the right in the “Relative 
Amount” column for FIL 4, and click. 

A horizontal bar appears, representing the portion of the fire area that is expected to 
burn at the selected level. The percentage that the bar represents is displayed in 
the “%” column. 

4 Continue clicking in the “Relative Amount” column for each FIL. You can adjust 
the bars by clicking and dragging them. The percentages are revised 
automatically. 

5 If you’re using separate FIL settings, continue by selecting different alternatives 
and outcomes, and FMZs, and repeating Steps 3 and 4 above.  

 
ä Worksheet 4: Individual Items 

1 When you click the Individual Items tab, you’ll see a box for listing items 
threatened on the left, and a table to the right that you use to enter the dollar 
impact for each outcome.  

2 To start the list of items threatened, you click the Add Item button. 

3 Type in an item. 

4 Click in the appropriate row in the “+Gain/-Loss” column in the table. 

5 Enter the estimated gain or loss for each outcome. 

If you expect a loss, precede the dollar amount with a minus sign. Otherwise, WFSA 
Plus assumes the amount is a gain. 

6 To add an item, repeat Steps 2 through 5 above for each item you want to add. 

7 To delete an item, just select it in the Individual Items Threatened list, and then 
click the Delete Item button. 

ä Worksheet 5: Summary 

1 When you click the Summary tab, you’ll see a drop-down list of the alternatives 
and outcomes, and boxes that summarize the expected impacts and suppression 
costs. 
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2 Click on the Outcome drop-down list to select the alternative and outcome you 
want to review. 

You’ll see the estimated fire size in parentheses to the right of the outcome. 

For the outcome you select, 

 In this box You’ll see 

 Total acre impact The impact on resources per acre (assigned in a WFSA 
Prep file or the NVC Table of the Setup section) multiplied 
by the estimated fire size. 

 Total impact on 
items 

The total value of the items you entered on the Individual 
Items worksheet. 

 Total impact The sum of the figures in the Total acre impact and Total 
impact on items boxes. 

 Suppression costs 
based on fire size 

The per acre estimate (assigned in a WFSA Prep file or on 
the Cost/Acre worksheet of the Setup section) multiplied 
by the estimated fire size. 

 Cost of suppression 
resources 

The Total Suppression Costs figure from the Suppression 
Resources worksheet of the Alternatives section. 

 Average of the two 
values 

The average of the Suppression costs based on fire size 
and the Cost of suppression resources figures. 

Note If you wish to adjust the amount in the Total impact on items box, refer to 
Worksheet 4: Individual Items on page 38. 

3 Once you’ve reviewed the two suppression cost figures and the average of the 
two, you can type a revised cost estimate into the box at the lower right. 

Say, for example, that the costs for previous fires that were the same size as the 
current fire were high. If the strategy calls for fewer than usual resources and 
you expect a lower cost, you may want to revise the suppression cost figure. 

4 The estimated costs and impacts are combined in the Total Cost + Loss box at the 
bottom of the worksheet. 

5 To continue reviewing and adjusting the estimated impacts and costs for other 
outcomes, repeat Steps 2 through 4 above. 

When you’re ready to see how the alternatives compare, click the Comparison tab 
and go on to Section 6 / Comparison. 



Guide to WFSA Plus 
 
40

Section 6   /  Comparison 

Once you’ve identified the alternatives and rated the outcomes for each, you’re ready 
to see how the alternatives compare, and to choose an alternative. In this section, 
WFSA Plus shows you how the alternatives compare according to the ratings you’ve 
assigned. 

WFSA Plus automatically summarizes the evaluation ratings you entered, and 
examines each in light of the probability that each outcome will occur. Then each 
rating is weighted according to the priorities you assigned. 

You can compare alternatives using a graph, decision tree, or matrix format, and then 
indicate which alternative you recommend. 

You use the Decision worksheet to state your decision and the reasons for it. 

ä Worksheet 1: Introduction 

When you click the Comparison tab, you’ll see the Introduction worksheet, which 
provides an overview of the Comparison section. 

ä Worksheet 2: Graph 

1 To view the alternatives in graphs, click the Graph tab. 

You’ll see two bar graphs. 

2 In the top graph, you compare the alternatives based on evaluation objectives: 

• The legend at the right lists the categories used to evaluate the alternatives 
(Safety, Economic, and so on). 

• The labels below the bars are the names you assigned to the alternatives. 

• The height of each bar shows how well each alternative scored overall, with 
10 being the highest possible rating. 

• The height of each color in each bar shows the impact of each category. 

3 In the bottom graph, you compare the alternatives based on costs: 

• The legend at the right lists the three cost areas: estimated costs of 
suppressing the fire, estimated values of resources affected by it, and the total 
of the estimated suppression costs and resource values. 

• The labels below the bars are the names you assigned to the alternatives. 

• When a bar drops down from the zero point, it shows there was a dollar 
loss. That is, resources or impacts cost money. Notice that the dollar amounts 
on the chart appear with minus signs. 

• When a bar extends up from the zero point, it shows there was a dollar 
gain. This occurs occasionally in assessing the impacts from the fire. In this 
case, the total cost takes into account the gains as well as the losses. 
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ä Worksheet 3: Decision Tree 
 
1 When you click the Decision Tree tab, you’ll see two alternatives at a time. 

At the top left of each decision tree, you’ll see a drop-down list of the alternatives. 
Using these lists, you can change the alternatives that are displayed. 

Here’s what you’ll see in the decision trees: 

• For each alternative that is displayed, you’ll see an Expected Score and an 
Expected Cost+Loss; for each outcome, you’ll see a Score and a Cost+Loss. 
The scores are based on how well the objectives are met; the cost + loss 
numbers are the total estimated suppression costs plus the dollar value of the 
impact on resources. For the alternatives, the Expected Score and Expected 
Cost+Loss are figured based on the probability of each of the outcomes. 

• To the right of each alternative, you’ll see its probability of success.  

• If you selected the first level of analysis on the Outcomes worksheet of 
the Alternatives section, the branch under each Target Outcome displays the 
Worst Case Outcome. 

• If you selected the second or third level of analysis on the Outcomes 
worksheet of the Alternatives section, the branch under each Target Outcome 
displays the Fallback Plan. The Fallback Plan shows the Fallback and Worst 
Case Outcomes and the probability of success for the Fallback Outcome. 

• For each outcome, you’ll see the final size estimate that was entered into 
either the Outcomes worksheet of the Alternatives section or the Potential 
Size worksheet of the Situation section. 

• For the Target and Fallback Outcomes, and the Worst Case Outcome, if the 
third level of analysis was selected, you’ll also see the time to contain and 
time to control estimates that were entered into Outcomes worksheet of the 
Alternatives section. 

1 You use the drop-down lists to select the different alternatives, and compare the 
results. 

 
ä Worksheet 4: Matrix 

1 Click the Matrix tab. 

At the top of the matrix, you’ll see the suppression costs and the change in resource 
values (gain or loss) as a result of the impact of the fire. 

Next, you’ll find the total financial impact of the fire. 

Beneath that row, you’ll see the column headings “Objective,” “Wgt,” and “A1,” 
“A2,” “A3,” “Alt A” and so on. “A1,” “A2” and “A3” represent the target, 
fallback and worst case outcomes for the first alternative you described on the 
Strategies worksheet of the Alternatives section. “Alt A” represents the first 
alternative. 

2 Compare the “Total financial impact” of each alternative. 
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3 Review the “Total Score” for each alternative. 

In the “Total Score” row, you’ll find the overall score for each alternative. The higher 
the number, the better the alternative meets the objectives you identified and 
prioritized. 

4 Review the relative importance of each category for each alternative. 

As you read across a category row (“Safety,” for example), you’ll see a number for 
each alternative. This number is the combined rating of all of the objectives in the 
category for that alternative. The higher the number, the better the rating. 

5 Review the relative importance of each objective within each category for each 
outcome. 

As you read across an objective row (“Firefighter Safety,” for example), you’ll see a 
number for each outcome. This number is the rating for that alternative. The 
higher the number, the better the rating.  

ä Worksheet 5: Decision 

1 When you click the Decision tab, you’ll see a drop-down list of the alternatives 
for attacking the fire, and boxes that help you to fill in the Decision Summary 
pages of your report. 

2 In the Select an Alternative drop-down list, select the alternative you’re planning 
to use. 

3 In the Strategy Description box, the outcome description that you entered into the 
Outcomes worksheet of the Alternatives section appears. If needed, click in it to 
edit information. 

4 To summarize the reasons for your decision, click in the Rationale box, and type in 
your reasons, including the key points. 

Click the Complexity tab and go on to Section 7 / Complexity, so you can rate the 
complexity of the fire. 
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Section 7  /  Complexity 

In this section, you determine how complex the fire situation is by selecting elements 
that describe the situation. The elements are grouped into categories such as Safety 
and Fire Behavior.  

The number of elements you select in each category determines its complexity rating. 

After analyzing the elements and the category ratings, you determine what type of 
incident the current fire is and type in your rationale. 

ä Worksheet 1: Introduction 

When you click the Complexity tab, you’ll see the Introduction worksheet, which 
provides an overview of the Complexity section. 

ä Worksheet 2: Complexity Analysis 

1 When you click the tab, you’ll see the Category list and a series of statements 
(elements) for the highlighted category. 

2 The “Fire Behavior” category is highlighted. You can begin with “Fire Behavior,” 
or click a different category to select it. The elements for the selected category 
appear in the Elements for list. 

3 Click the check box to the left of an element to select it. 

When a 4 appears in the check box, it means that element is selected. 

For each category, as you select elements, you’ll see the number of elements selected 
in the Category box. Considering the number of elements selected, the category is 
rated Low, Medium or High. 

If you select the category is 
rated 

0 elements in a category Low 

At least 1 element Medium 

More than half of the elements High 

Note  To add an element that’s not in the category, click the Add Element button, and 
then type the element in the box provided. To delete an element, click the Delete 
Last Element button.  

4 When you finish selecting elements for a category, click another category in the 
Category box, and then select the elements that apply.  

ä Worksheet 3: Guidelines 

1 To review the National Wildfire Coordinating Group (NWCG) guidelines for 
determining the complexity of the current fire, click the Guidelines tab. You’ll 
see a series of buttons. 

2 Click on each button to see the relevant portions of the guidelines. 
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ä Worksheet 4: Incident Type 

1 When you click the Incident Type tab, at the left you’ll see a list of each of the 
categories that were rated Medium or High on the Complexity Analysis 
worksheet. You can scroll through the list to review the elements that you 
selected. 

In the box at the right, you’ll see each category, along with its rating, and the number 
of elements that were selected for it. 

In the Summary box, you’ll see the number of categories rated Low, Medium or High, 
the total number of elements you didn’t select (No) and those you selected (Yes). 

2 After reviewing the elements, you can indicate the incident complexity by filling in 
the Incident Complexity box at the bottom of the screen. 

3 In the Rationale: box, you type in a rationale for the Incident Complexity Type you 
entered. 

Click the Report tab and go on to Section 8 / Report to edit and print your decision. 
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Section 8  /  Report 

Once the alternatives have been analyzed and compared, you communicate your 
decision to everyone concerned. 

In this section, you add instructions and information and state your decision and the 
reasons for it, along with any special considerations that people need to be aware of 
to carry out the decision. You can also preview and print the WFSA report. 

ä Worksheet 1: Introduction 

When you click the Report tab, you’ll see the Introduction worksheet, which provides 
an overview of the Report section. 

ä Worksheet 2: Topics 

1 To review the selected alternative and complete the report, click the Topics tab. 

You’ll see the alternative you’ve chosen in a box at the top. Below it are boxes that 
allow you to fill in the decision summary topics of your report. 

2 In the Decision Summary Topics box, you see the topic names for the Summary 
page of the WFSA report. Click a name to enter, view or edit information: 

• “Description” (The description typed into the Outcomes worksheet of the 
Alternatives section appears so you can edit it, if needed.) 

• “Rationale” (The rationale typed into the Decision worksheet of the 
Comparison section appears so you can edit it, if needed.) 

• “Special considerations” (for instance, protecting endangered species) 

• “Information policy” (such as names of people to contact for more 
information) 

The cursor moves to the Body box so that you can enter or edit the information. 

1 To change a topic heading, click its name in the Decision Summary Topics box; 
then click in the Heading box and edit the heading. 

2 To add a topic, click the Add Topic button and type in the heading and body 
information. 

For example, to add a list that names the people who have prepared your WFSA 
report: 

 
1) Press Tab to move to the Body box. 

2) Click the Add Topic button. 

3) Type in your heading. 

4) Enter the names of the preparers. 
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ä Worksheet 3: Print Report 

1 When you click the tab, you’ll see the previewing and printing options that are 
available. 

2 To preview or print: 

• the full report, click the Select All button to be sure every page is selected. 

• selected pages, click the Clear All button and then click the check boxes 
next to the pages you want.  

 An x in a check box means that page is selected. 

Note  If you have a color printer, you can print WFSA charts and graphs in color. The 
Graph Colors box allows you to preview and print in black and white patterns, 
colored patterns or solid colors. To select an option, click in the appropriate circle. 

3 Click the Preview button if you want to see your choices as they will appear 
when printed. 

4 The Print Preview screen appears. 

From the Print Preview screen, you can 

 Click this button  To do this 

 Left or right arrow  View other pages, if you’ve selected more than one page. 

 Magnifying glass Zoom in to enlarge a portion of the page or out to see more 
of the page. 

 Save to File Save a formatted version of the report to a Rich Text 
Format (rtf) file. 

 Print Page  Print the page you see. 

 Print Report  Print the WFSA report. 

 Close  Return to the Print Report worksheet. 

Note  You can also zoom in to a smaller portion of the page by double clicking the 
portion you want to view. 

5 When you return to the Print Report worksheet, you can: 

• preview other pages by repeating Steps 2 through 4. 

•  click the Print button to print your selections. 

• review and change your printing options by clicking Printer Setup. 

• click the Save to File button to save your selections to a Rich Text Format 
(rtf) file. 

Note  There are two issues to be aware of when saving to an RTF file.   
First, on the Graph page, patterns are not supported in the RTF file, so the graphs 
will be transferred using solid colors, regardless of the setting in the Graph Colors 
box.   
Second, on the Signature Page, several of the clumn headings are turned 
sideways: the text runs vertically rather than horizontally.  In the RTF file, this 
formatting is lost.  However, it can be easily restored by most word processors.  
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For example, in Mirosoft Word, select Text Direction from the Format menu to 
change the orientation of the text. 

When you’re through previewing and printing reports, you can: 

• go to one of the WFSA sections and worksheets by clicking a section tab and 
then a worksheet tab. 

• switch to the WFIP program by selecting Go to WFIP from the File menu. 

• quit WFSA 03 by selecting Exit from the File menu. 



Guide to WFSA Plus 
 
48

Interpreting the results 

There are some special features that work behind the scenes as you use WFSA Plus. 
These features are mostly mathematical and are used to produce things like the 
comparison tables you’ll see as you work. 

Note  We include this discussion here for interested readers. Understanding 
probabilities and how costs are estimated aren’t required to use the software. 

Probabilities 

Many of the computations in WFSA Plus take into account the probability that a 
certain outcome will occur. 

The probability of a successful outcome is the same as the probability of success of 
the primary strategy, or target outcome. The probability of the fallback outcome, on 
the other hand, isn’t the same as the probability of success of the fallback plan. Since 
the fallback plan is only used if the primary plan fails, the probability of the fallback 
outcome is the probability that the primary plan fails times the probability of success 
of the fallback plan. 

For example, suppose the probability of success of the target outcome is 60 percent 
and the probability of success of the fallback plan is 80 percent. 

The chance that the target outcome will occur is the same as the chance of success 
of the primary strategy–in this case, 60 percent. The probability that the fallback 
outcome will occur is the probability that the primary strategy will fail times the 
probability of success of the fallback strategy–in this example, 40% x 80% = 32%. 
The probability that both plans will fail and the worst case situation will occur is 40% 
x 20% = 8%. Note that the probabilities of the three outcomes add up to 100 percent–
60% + 32% + 8% = 100%. 
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Expected Costs 

The expected costs for an alternative are computed by multiplying the cost for each 
outcome by the probability that that outcome will occur, then adding the results. 
Suppose, in our previous example, the suppression cost for the target outcome would 
be $100,000, the cost for the fallback outcome would be $300,000, and the cost for the 
worst case outcome would be $1 million. We would compute the expected cost as 
follows: 

$100,000 x 60% =  $60,000 
$300,000 x 32% =  96,000 
$1,000,000 x 8% =    80,000 
Expected cost:   $236,000 

Therefore, the expected cost for the alternative would be $236,000. Note that this is 
an intermediate value–it’s more than the $100,000 that the target outcome would cost, 
but less than the $1 million that the worst case outcome would cost. 

It’s important to realize that if the final cost of the fire turns out to be $100,000, it 
doesn’t mean that the expected cost of $236,000 was the wrong answer. The 
expected cost predicts the average cost of a series of fires, not the actual cost of any 
individual fire. If there were 100 fires similar to this one, we would expect 60 of them 
to end up costing $100,000 dollars, 32 of them to cost $300,000, and 8 of them to cost 
$1 million. The average cost of all 100 would be $236,000. The expected cost takes 
into account uncertainty about the future. Therefore, it’s the best value to use when 
comparing the cost of one alternative with another. 

Precision 

Most of the computations WFSA Plus makes for tables and graphs are rounded off to 
three digits of precision when they are displayed. This is to avoid giving the impression 
of extremely precise computations, when in fact the numbers are only estimates. 
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Terminology 

Here are some of the key terms used in WFSA Plus: 

Alternative 

An overall method of controlling the fire, including a primary strategy, a fallback 
strategy and, if needed, a worst case scenario.  

Category 

A group of objectives or elements. A way of organizing material in WFSA Plus. For 
example, Safety is one of the categories in which you evaluate alternatives.  

Element 

An item to be taken into consideration when determining how complex the fire is. For 
example, in the category of Resources Threatened, “Cultural sites” is an element.  

FIL Fire Intensity Level  

FMZ Fire Management Zone  

IIAA Interagency Initial Attack Assessment  

Objectives 

The goals that you and other managers think the chosen alternative should meet.  

Outcome 

The end result of a strategy in terms of its success or failure. Each alternative can 
have up to three outcomes:  

• the desired, target outcome, 
• a fallback, or contingent, outcome and  
• a worst case outcome. 

RMA Resource Management Area 

Strategy 

 An approach to controlling and containing the fire.  

WFIP Wildland Fire Implementation Plan  

WFSA Wildland Fire Situation Analysis  
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Technical support 

For technical support please call John Szymoniak at NIFC at 208-387-5748. 

Email: jszymoniak@fs.fed.us 

 

To make suggestions for future versions of the software, please contact: 

BalanceTech, LLC 
534 Fairview Avenue 
Missoula, MT 59801 

balance@balancetech.com 

 

 
 


